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Abstract
Each paper must start off with an abstract (with the exception of case studies).  The abstract should be approximately 500 words and summarize the topic and findings of the paper.  It should also be italicized and be formatted in the same manner of the rest of the document (see instructions below).
When you complete your manuscript, we will ask you to submit the “camera ready” manuscript as a MS Word file (.doc or .docx). Please work with us to make the document look great! Follow these directions carefully, and the result will be a highly professional appearance.
If you are unable to format the manuscript, please email it to info@alliedacademies.org. We have an Editor under contract who will provide you with an estimate for formatting the manuscript for you. Unless the paper is very complex, the fee is generally $10 per page.
Introduction
The following sections of this document will give you some insight into how you can use this document as a template to create a nice looking paper.  However, you do not need use this file as a template if you are mindful in how you format your own document.  The aim is to make your document look “camera ready” so that we do not need to make any modifications. For your convenience a summary of the key elements is as follows.

· The page size for the document should be set to 8.5 by 11 inches.
· The margins should be set at one inch all around.
· The document must be single spaced.
· Turn on Widow/Orphan control and avoid headings to break over a page.
· Do not use headers or footers.
· The font used should be Times New Roman, 12 point (with the size exceptions mentioned below for quotes, tables, and references).
· The document must use full justification throughout (with the excepting of the headings that need to be centered).
· Each paragraph should begin with a left tab or first line indent of one half inch (typically the default tab option).
· There should not be any extra blank lines between paragraphs unless there is a section of text that needs to stand out from the other paragraphs.
· Title of the paper must be in ALL CAPITAL LETTERS, bolded, centered and in 18 point font.
· The Author’s names and affiliations should be in 14 point font, bolded and centered. Please do not use honorifics for author names (i.e. PhD, Dr., etc.)
· Main Headings in the document should be in ALL CAPITAL LETTERS, bolded and centered in the default 12 point font. Subheadings should be in Initial Capital Letters, bolded and left justified. Pay attention not to orphan a heading from the text that follows at the bottom of a page. More information on headings can be found in the sections below.
· If the paper contains hypotheses, lists, formulae, tables, figures, footnotes, etc., please read those sections below for more information.
· References should be in 10 point font, single spaced between references, with hanging indents (see section below for more instructions).

The important thing is to make your document look consistent with this document before it is submitted for publication.
USING THIS FILE AS A TEMPLATE
This document, which can be used as a template, has been prepared in the correct format. That is, we defined the “Normal” and the Heading 1, 2, 3, 4, and 5 tabs in the tool bar at the top to produce the correct document. If you use this template you will need to copy and paste material into this document to prevent Microsoft Word from keeping the format layouts from your other file (paste by keeping destination format). If you do not use this template, then you will need to modify the defaults in the various tabs in the tool bar. We will describe the changes in the following sections.
There should be no headers and no footers in the document. The page size should be set to 8.5 by 11 inches, and the margins should be set at one inch all around. Set the defaults in the Normal tab to be Times New Roman, 12 point typeface, and full justification for the document. You may decide to utilize a first line indent command set to one half inch, but if you do, be sure to remember that the command will also affect contents in your tables and in all layouts for the entire document. Set paragraph spacing to zero, both before and after the paragraph. Set spacing to single. Turn on Widow/Orphan control. We prefer for you to use only one space between sentences, rather than the older approach of double spacing between sentences.
Headings
To make changes to any of the heading tabs in the toolbar, right click on that tab and click on “modify.” This will allow you to structure the heading as you desire. Additional changes can be made by opening the “format” tab at the lower left of the “modify” box. Define “Heading 1” to be Times New Roman, 18 point, bold, all upper case, and centered on the margins (be sure not to let a first line indent command affect the centering). Choose 12 point paragraph spacing after the paragraph. You will only use the Header 1 command for the title of the article. Do NOT use the Header 1 command again anywhere in the document. Highlight the title and click on “Heading 1.” 
Define “Heading 2” to be Times New Roman, 14 point, bold, initial capitals, and centered on the margins (be sure not to let a first line indent command affect the centering). Choose 12 point spacing after the paragraph. You will only use the Header 2 command for the names of the authors. Highlight the authors and their affiliations and click on “Heading 2.” Do not use titles or honorifics with the authors. That means that you will type each author’s name, followed by a comma, and that author’s affiliation. Do not include Ph.D., Dr., Professor, or other titles or honorifics. For the affiliation, type the name of the University or the name of the employer of the author.
Present the authors in the order in which they have contributed to the work, and type them one per line (do not double space between authors). When all have been typed, highlight all of the authors and affiliations at once, and click on “Heading 2.” Do NOT use Heading 2 again anywhere in the document.
Define “Heading 3” to be Times New Roman, 12 point, bold, all upper case, and centered on the margins (be sure not to let a first line indent command affect the centering). Choose 12 point spacing both before and after the paragraph. You will use the Header 3 command for ALL major headings inside your document. This will include Abstract, Introduction, etc. Just highlight the text to be used for the heading and click on “Heading 3.”
Subheadings
If you require subheadings to make the manuscript flow better, define “Heading 4” to be Times New Roman, 12 point, bold, initial capitals, and set at the left margin (be sure not to let a first line indent command affect your setting). Chose 12 point spacing both before and after the paragraph.
Subtitle Example
You will use the Header 4 command for all subtitles that will appear in the article. The subtitle should be prepared with initial caps, as shown in this example.
Sub-Subtitle Example
We recommend that you avoid using a Sub-Subtitle. We find that they do not help in reading a manuscript, and they tend to make the manuscript appear choppy. However, if you feel that you need to use a Sub-Subtitle, define “Heading 5” to be Times New Roman, 12 point, bold, initial capitals, and set to indent one half inch (be sure not to let a first line indent command affect your setting). Chose 12 point spacing both before and after the paragraph.
We do not permit subheadings below this level. If your current manuscript includes any lower level headings, please revise it to eliminate those.
HYPOTHESES
When you need to include hypotheses in your paper, put them in 10 point font, and italicize them. Indent them from the left margin, by highlighting the hypothesis and dragging the double tab button (located on the ruler bar) to the one half inch position; then drag the lower tab button to the 1 inch position. You may need to open the View tab and select “Show Ruler” in order to see the ruler. See the example below.

H1	This is my first hypothesis. Maybe it will be found to be true. If it is, then all of us will really be extremely pleased!

H2	This is my second hypothesis. Maybe it will be found false.

H3	This is my third hypothesis and it uses a subscript.

So, that is what an average hypothesis statement looks like. If you would like to put the numbers in subscript, you may do so. If you would like to spell out the word hypothesis, you may do so. 
Lists and highlights
If you have material which you would want to include in the form of a list, please do NOT use bullet points. You may number the items or just omit bullets or other indicators. Offset the material the same way you would with hypotheses with a line above and below, and change it to 10 point type. Highlight the material and drag the double tab button on the ruler bar to the one half inch position, then drag the lower triangle on the ruler to the one inch position. Here is an example.

This is the first example of listed material and it will be highlighted in the text by its location and appearance.
This is the second example of listed material. You could number these items, if you prefer

Here is the same example, but this time, we use numbers for each of the items in the listed material. We like to avoid bulleted lists because the variety of bullets varies greatly between manuscripts and impacts the overall appearance of the journal.

1. This is the first example of listed material and it will be highlighted in the text by its location and appearance.
2. This is the second example of listed material.

If you have material that you wish to highlight, such as a quotation from another researcher or some statement from a research subject, offset it with a line above and below, and change it to 10 point type. Highlight the material, drag the double tab button on the ruler bar to the one half inch position, then covert the material to italics. Here is an example.

When we were doing the literature review, we found this quote to be very insightful, and we wanted to present it as a highlighted item in the manuscript.
FORMULAE
When using formulae, you may want to use the software called Math Type, made by Decision Science. It plugs nicely into Word and is available for a nominal fee with your academic discount. You may find it at http://www.dessci.com/en/products/mathtype or you may use a different package. Just present the formulae the way you want them to appear in the final version of the manuscript. 
Below we have inserted some meaningless formulae just to serve as an example. In this example we offset the equation by one half inch, then set a left tab on the ruler bar at the margin to handle the display of the equation number. You change the type of tab on the ruler bar by clicking on the little icon at the far left edge of the ruler bar. The type of tab will change, and then you can click on a location within the ruler bar to insert the newly defined tab.


	(1)

When you have certain formulaic characters that are simply italicized letters (i.e. r, z, etc.) that you would like to include in the body of a paragraph, it is best just to use the letter rather than a formula box. Formula boxes in the body of paragraphs can alter the line spacing, which we would like to avoid, if at all possible.
TABLES
We encourage you to submit your tables just as you would like them to appear. With that in mind, we do have a few requests to maintain some consistency from one paper to the next. We would like for the table contents to be in 10 point font (or smaller if the size of the table calls for it) and centered on the page. Tables should NOT exceed the width of the one inch margins of the document. Please include the table’s title inside the borders of the table as shown below. The table title should be centered and bolded, and in the same size font as the rest of the table.
Left justify, center, or right justify columns in your table to make your material more readable, as you desire. Please note that an auto indent setting in your “Normal” tab will affect the contents of your table. To correct this, highlight the table, open the “Paragraph” box in the “Home” tab, and remove the first line indent instruction. Also, please place the tables in the body of the document where you would like them to appear. If the table breaks a page, move text material from above or below to keep the table on one page. If the table cannot fit on one page, set the title and the descriptive rows to “repeat” on the following page. Here is an example.

	Table 1
DESCRIPTION OF STUDY
Table Title on the Inside

	COMPANY 
	Name
	DATE

	ABC
	A Name
	1/1/2010

	DEF
	B Corp.
	1/2/2009

	GHI
	C. Name
	5/5/2008

	WXY
	D. Inc.
	7/21/2007



If your table is extremely complex, or extremely large, you can try to get it to work by sizing down the font to 9 point, or even 8 point. Do NOT go below 8 point type as that will make it extremely difficult to read your table. If you are still unable to get your table to work on the page, then you must create it as a jpg and shrink it to fit.
We do not accept landscape tables or figures. You must scale the table to fit in portrait mode. If you are unable to handle this yourself, you may contact us for advice or engage us to handle the conversion.
We might advise you concerning tables, that extremely complex, or busy tables are difficult to read, and do not add to the manuscript. It is better to use simple tables, even if you need more of them, than to create something that no one can understand.
Figures
[bookmark: _GoBack]Your figures should always be centered, and should have a title for reference purposes. When you create figures, remember to use Times New Roman as the font in the figure, and think about how it will look in the journal. Generally, figures should not exceed 6 inches in width.  Keep in mind that the hard copy journals are printed in black and white, which might alter how you format your figures. The PDF versions will be in color. Put the figures where you want them to appear and format them the way you want them to look in the final document. 

Figure 1

If you have extremely complex figures, or if you have trouble placing them in the manuscript, you may need to consider engaging us to process the figures. You may contact us for a price quote for any aspect of the formatting process.
CITATIONS AND FOOTNOTES
Please use APA style for all of your publications. The American Psychologist’s Association Style Manual does NOT employ footnotes. Instead, a citation is handled in the body of the text (Carland & Carland, 1984), by putting the last names of the authors, followed by the year of the publication within parentheses. If there are multiple citations with a single sentence then separate the articles with a semicolon (Carland & Carland, 1984; Stewart, Carland & Carland, 1997). If the citation occurs at the end of the sentence, it should be inside the period. If you cite specific information, or you quote a reference, add a page number after the date. We present examples of the proper approach to citation a bit later in these instructions.
Please try NOT to use footnotes or endnotes. Instead, please include that supplemental material in the body of the text (in parentheses if necessary). If you absolutely cannot avoid using a note, please use endnotes. Put the Endnotes in front of the References. The title, Endnotes, should be a “Heading 3,” and the endnotes should be in 10 point type, numbered and indented with a hanging indent. To create a hanging indent, highlight the text, drag the upper triangle indicator in the ruler bar to the left margin, then drag the lower triangle indicator in the ruler bar to the one half inch position. This will indent all of the second lines of the notes.
Endnotes
1	As we indicated, we want you to avoid endnotes when you can. If you feel that you must have them, make them look like this and insert them just before the “Refreences.”
references
References should be entitled “References,” and should be a “Heading 3” highlight. Remove tabs, or hard returns, or other attempts to format your references, then highlight the entire group of references. Click on 10 point type in the Home tab, then drag the upper triangle in the ruler bar to the left margin, and drag the lower triangle in the ruler bar to the one half inch position. This will create a hanging indent.
References should be prepared in general accordance with the APA (American Psychological Association). We do deviate from APA style with respect to underlines. These do not reproduce well, consequently, we ask that you use italics in place of underlines. Single space between references and do NOT use underlining ( ___ ) at the beginning of a reference as a shortcut. In fact, do NOT use underlining anywhere in the document.
Below are some examples of different citations. Please note that if you have a break problem because of a website, you should manually choose a break point by inserting a space into the citation. 
Citing a Journal Article
Carland, J.W., F. Hoy, W.R. Boulton & J.A. Carland (1984).  Differentiating entrepreneurs from small business owners. Academy of Management Review, 9(2), 354-359. 
Citing an Online Journal Article
Fredrickson, B.L. (2000). Cultivating positive emotions to optimize health and well-being. Prevention & Treatment, 3, Article 0001a. Retrieved November 20, 2000, from http://journals.apa.org/prevention/ volume3/pre0030001a.html
Citing a Book
Carland, J.W. & J.A. Carland (1999).  Small business management: Tools for success (Second Edition).  Houston, TX: Dame Publishing.
Citing an Article in a Magazine
G. Gendron & B. Burlingham (1989, April). The entrepreneur of the decade: An interview with Steve Jobs, Inc., 114-128.
Citing a Proceedings
Carland, J.A., J.W. Carland & W.H. Stewart (2000). The indefatigable entrepreneur. Proceedings of the Association of Small Business and Entrepreneurship, 168-180.
Citing a Presentation
Ensley, M.E., J.A. Carland & J.W. Carland (May, 1998). The lead entrepreneur. Presented to the Babson College Entrepreneurship Conference, Gent, Belgium.
Citing an Article in a Book
Brockhaus, R. H. (1982). The psychology of the entrepreneur. In C. Kent, D. Sexton, & K. Vesper (Eds.), Encyclopedia of Entrepreneurship (pp. 39-57). Englewood Cliffs: Prentice-Hall.
Citing an Internet Source
GVU’s 8th WWW user survey. (n.d.) Retrieved August 8, 2000, from http://www.cc.gatech.edu/gvu/ usersurveys/survey1997-10/
Citing a Dissertation
Carland, J. W. (1982). Entrepreneurship in a small business setting: An exploratory study. Unpublished doctoral dissertation, University of Georgia.
Citing a Film
R. LaPointe & H. Glazer (Executive Producers) (1992). H. Ross Perot: A vision for success in the ‘90s. Boston, MA: Goldhirish Group, Inc.
conclusion
This concludes our formatting guidelines, unless you are preparing a case. Guidelines for case preparation follow this section. If you have any questions or issues, please email us at info@alliedacademies.org for clarification. We have an Editor under contract who will format your manuscript for you, and the fee is normally US $10 per page. In the case of extremely complex manuscripts which have extensive formulae, figures or tables, the fee might be higher, but we can look at your manuscript and quickly let you know what the cost might be in advance.


GUIDELINES FOR CASES
Prepare cases as described above with these exceptions. First, instead of an abstract, begin the case with a “Case Description” and a “Case Synopsis,” both in italics as illustrated below. Technical information is in the Description, while the Synopsis should gain the reader's interest. The body of the case should follow the synopsis, separated by a heading. Prepare the “Instructors’ Note,” described more fully below, in accordance with these instructions as well. The description and synopsis are important as they communicate basic information about the case to the reader. Never forget that the Note is actually more important than the case, at least in the perspective of accrediting agencies for your university!
CASE DESCRIPTION
The primary subject matter of this case concerns (describe the most important subject, ie, entrepreneurship/conflict management/ethics/etc.). Secondary issues examined include (list as many as the case contains just like for the primary subject). The case has a difficulty level of (choose one of the following: one, appropriate for freshman level courses; two, appropriate for sophomore level; three, appropriate for junior level; four, appropriate for senior level; five, appropriate for first year graduate level; six, appropriate for second year graduate level; seven, appropriate for doctoral level). The case is designed to be taught in (indicate how many) class hours and is expected to require (indicate how many) hours of outside preparation by students.
CASE SYNOPSIS
In this section, present a brief overview of the case (a maximum of 300 words). Be creative. This section will be the primary selling point of your case. Potential case users are more apt to choose cases for adoption which catch their fancy.
The Case Description and Case Synopsis are not used when the case is assigned to students. Their purpose is to inform instructors and prospective users of the case.

Case Body
The body of the case will follow the description and synopsis, and should be formatted in accordance with the forgoing instructions. Avoid using photographs or extensive exhibits which will make reading the case more difficult. The general rule of thumb is, if looking at this exhibit is not important to the decision point of the case, then omit it.
Please do NOT include assignment questions in the body of the case. These should be in the Instructors’ Notes. Leaving them in the case body will prejudice student readers, as they will seize on the assignments, ignoring much of the content of the case.
INSTRUCTORS' NOTES
Instructors' Notes are an important part of the referee process and must be included with all cases submitted for review or for publication in any form. Notes should be prepared in accordance with these publication guidelines and prepared as a separate manuscript and a separate file because the case notes are published in a different issue from the case. Cases are published in odd numbered issues, while notes are published in a companion even numbered issue.
Prepare Instructors' Notes for use by instructors who are not familiar with the case issues. The note should allow the instructor to teach the case without additional research.  Begin the note with a REPEAT of the Case Description and Case Synopsis. Follow the Case Synopsis with Recommendations for Teaching Approaches. Specific questions, assignments or teaching methodologies should follow. Be sure to INCLUDE ANSWERS for all questions or assignments. Please do not include the questions and assignments in the case, but include them in the Instructor’s Note instead. This gives instructors more flexibility in what to assign. Epilogues, if appropriate, should close the note. If your case is from library research, include the references for all material used in a REFERENCES section.
conclusion
This concludes our formatting guidelines. Thank you for sharing your work with us. We look forward to publishing many more of your manuscripts!
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